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Stephen Lilly PowerPoint is part of Microsoft Office line performance computer programs. PowerPoint lets you create a slideshow on your computer, which can be a great way to give a business presentation or even a school report. PowerPoint comes with a number of default images called clip art built in
for your use. However, you can also convert the image on your computer's hard drive into a PowerPoint presentation template. Click the File and then Open. Open the PowerPoint template to which you want to add a picture. Click from the file. Use the window that appears on the screen to select the
image file from your computer's hard drive. It will then be inserted into the PowerPoint template. You can click on it to drag it and place it anywhere in the template you want it to be. Most people know that you can create PowerPoint presentations with photos, music, images, web content, and text, but one
little-known trick is the ability to keep PowerPoint presentations as videos. PowerPoint presentations have long been a favorite to use in business and academic presentations around the world. They are very versatile and offer a wide range of features that you can use to enhance them. In order to keep
PowerPoint as a video you will need to first create a presentation or download the sample we used for this tutorial. Once the document is open, you will need to save it as a video. Start by clicking the file. Instead of following the logical thought and opening the Save section, you'll need to click on the
Export button and then click on the Create video button. Once you do that, you'll see the Create Video option. This will offer multiple options in the form of two drop out menus and a time value field. The first drop box where you will choose the quality of the exported video. These three options will also
determine the size of the video file being exported. For the purposes of this example, we will choose the second option to reduce the size of the video without compromising the too much quality of the video. The second drop-off menu allows you to include or exclude any timings or narrations you inserted
into the PowerPoint presentation. Since the sample document has no timings or narratives, we will leave it as it is. Using recorded timelines and narrations will be unavailable if you don't have any of them in the presentation. The time field is a place where you can edit the amount of time your slides will
appear in a video. The default time is set at 5 seconds. For this tutorial, we will install it for 3 seconds. Finally, click on the Create Video button. Now you will be delivered to Save the window. Browse the place where you want to save the file and give it a name, and then click Save. While the video is being
created, you will see you see the progress bar at the bottom of the PowerPoint window. Wait until it's done and then go to the video. Now you can double-click on the video file and it will automatically play with your video player. Remember that the more slides you have and the more time you know to
each slide, the more video space will eventually take up. This handy export tool is great for automating presentations or uploading them as videos to online video sharing services such as Facebook or YouTube. If you have a PDF file that you would like to convert to a PowerPoint presentation, you can
download the program to quickly do the work for you, or you can use one of the many available online converters. Converting the PDF file into PowerPoint Using Adobe Acrobat DC Adobe Acrobat has several different software options for processing PDF files to choose from - Acrobat Standard DC and
Acrobat Pro DC. The standard version is windows only, while the pro version works with both Windows and Mac. They work for $12.99 and $14.99 per month, respectively, so if you're already using one of them, it's probably not worth the money just to convert a PDF file into a PowerPoint. However,
Adobe Acrobat is the best program on the market for anything that deals with PDF files, so we recommend subscribing to one if you often do any work with PDF files. Best of all yet, the Acrobat Pro DC has a free trial, so if you're not familiar with Adobe Acrobat, it's worthless to give it a try. In this example,
we will use Adobe Acrobat Pro DC. Open the PDF file you want to convert. In the right window glass, select Export PDF. Now you will be faced with a list of different export options. Select Microsoft PowerPoint from the list and select Export. In Windows Explorer (or Finder, if you're using a Mac), select a
place to save the file and select Save. Open the newly saved PowerPoint, and you'll see the contents of the PDF file (with each slide representing one page) in the preview panel. Converting the PDF file into PowerPoint Using an online PDF Converter There's certainly no shortage of online PDF-creatorssome free, some paid. We recommend Smallpdf because it's fast, free, and keeps the content format pretty consistent. We'll use this online tool for this example, but the process isn't too different between each converter, so feel free to play around and find the one you like the most. With SmallPDF, all
you have to do is drag and drop the PDF file on the converter screen, or you can use a file tester. Whichever method you choose as soon as the file is the conversion will automatically begin. Once the conversion is complete, select Download. Once you've completed the download, open the newly saved
PowerPoint, and you'll see the contents of the PDF file (with each single-page slide) in the preview panel. From class class to professional offices, presentations to convey information in a clear and illustrated format. Microsoft PowerPoint is one of the most reliable (and common) applications that create
presentations. Here's how to make a simple PowerPoint presentation. The instructions in this article apply to PowerPoint for Microsoft 365, PowerPoint 2019, PowerPoint 2016 and PowerPoint 2013. Here are the steps to create a basic PowerPoint presentation. Open powerPoint. The program can open
an empty presentation. If so, select New to see the options for creating a new slideshow. If you'd like to see the most popular PowerPoint features, go to File and then select a Welcome to PowerPoint template. Choose either a blank presentation or select one of Microsoft's design themes to create a
presentation. When you select a blank presentation, PowerPoint creates a one slide presentation that starts with a slide header. You can then select the text boxes on the slide header to add text. Topics include matching color palettes and fonts to help you create a document with a cohesive look. Add
additional slides to the presentation. Go to the Home tab and select the New Slide. Or tap the right Slide Sorter button in the left glass and select New Slide. If you want to change the slide layout. Go to the Home tab and select Layout. Then select the layout of the slide content that you can use as
needed. Repeat until you have enough slides to finish your presentation. Now that you've created a presentation framework, you can use some basic operations to make it more interesting. If you've chosen a pre-defined slide layout that includes text or image elements, click on any item. Choosing a text
box opens it up for editing. You can then enter or insert the content into the text box. Shared content boxes have icons to click to insert objects including tables, diagrams, SmartArt, photos, and videos. Add a text field to the slide. Go to the Insert tab and select the text box. Click any place in the slide to
place the box. When you start typing, the Home tab opens with text formatting options such as font, size, bold, italics, color and alignment. Text editing buttons are only available when choosing a text box. To size the text box, drag (click and hold with your mouse) one of the adjustment handles on the
outside of the text box until the text box is the right size. Add an image. Go to the Insert tab and find options in the Images group. Choose one of these options: Picture opens the browser file. Go to the photo on that you want to use. Online Picture opens the search box. Search Bing for images online or
use OneDrive to access photos. The screenshot captures part of the screen and adds it to the presentation. The photo album gets access to a group of photos on your computer. Adding other objects is also done through Insert the tab. You can drag and create shapes, SmartArt and charts. Don't leave a
new presentation without saving it. Alternatively, you can share it with someone or put it where you can access it easily. Save the presentation by selecting the File to Save As. You can also choose Save as Adobe PDF to convert the presentation into a PDF file. If you're using OneDrive, save your
OneDrive presentation for easy access and sharing. Select a file to see the options to share the presentation quickly. Depending on your other software, PowerPoint allows you to share through OneDrive, email and other options. PDF files are one of the most commonly used file formats in the world.
However, they are not easily amenable to being used in PowerPoint presentations. Of course, it's unlikely that you'll want to turn a 100-page academic document into a slideshow, but PDFs aren't just used for text. Many graphs, diagrams, and images are also distributed in PDF format. So, if you have an
informative PDF file that you would like to turn into a presentation, keep reading. We're going to show you how to convert a PDF into a PowerPoint file and then offer some formatting tips to help make it shine. As with most file format conversions, there are two ways to turn a PDF file into a PowerPoint file.
You can use a web app or a desktop program. Web app: Smallpdf With a bit of digging, you'll be able to find quite a few tools that can turn a PDF document into a PPT file. However, we like Smallpdf. In our testing, it was the most reliable and returned the most impressive results. The app has some other
significant benefits that users will appreciate. First, it is completely free to use. Second, Smallpdf doesn't save any of your files on its servers (it saves your file for one hour in case you want to download the conversion multiple times). Finally, it's completely web-based; you don't need to install anything on
your machine. To start the conversion, go to the Smallpdf website. Using the navigation bar at the top of the window, go to all the tools that convert from a PDF to a PDF to a PPT. Now you have to see the yellow box on the screen. There are three ways to add a file that you want to convert to a web
application. You can download the file from your computer (by dragging and falling or clicking Select File), adding a file from Google Drive (clicking on from Google Drive), or adding a file from Dropbox (choosing from Dropbox). Note: If you want to add a file from Google Drive or Dropbox, you will need to
give Smallpdf permission to access your account If you're uncomfortable doing this, download the PDF in question to your computer and then upload it to the web app. Once you've selected the file, the download process will begin. Depending on the size of the PDF, it may take a few minutes. Once the
download is complete, the conversion process will begin. Again, the amount of time it's will vary depending on the size of the original PDF. Eventually, you'll see the results screen. You can download the new PowerPoint file directly to your computer, or save it on Google Drive or Dropbox. If you want to
convert a second document, just click Start 1. Before you continue to read, the word warning. There are no free PDF conversion apps on your desktop to a PowerPoint file. The logic of developers is simple: very few people have to make the number of conversions that require the need for a special
desktop application, and those that probably use the tool in a professional environment. So which app is better? Well, Smallpdf also offers a desktop pdf conversion app to PowerPoint Presentations, but it's a new app and doesn't yet offer the same number of features as some of its more established
competitors. Two of the best-known desktop PDF converters are ILovePDF (offers a 15-day trial) and Adobe Pro DC (offers a seven-day trial). After that, for both PDF tools you will need to pay for the license. If you're looking for an obvious winner, it's hard to argue with Acrobat Pro DC. However, it will set
you back $14.99 per month. If you only make random conversions, the cost of a subscription is hard to justify. With if possible, you can use the Adobe Pro DC app (and thus make conversions) from any device, choose which parts of the PDF file you want to convert, and customize pre-defined PPT
formats. If you're looking for a cheaper alternative, try Wondershare PDFelement. It still costs $59.95, but it's a one-time fee for a lifetime license. Again, a trial period is available, so you can try before you buy. To convert the PDF file to PPT, start the app and open the original file. Next, click on the Home
tab and select The Other on the right side of the tape. The save dialogue will pop up. Choose PPT's Save as the type of drop out menu and hit Save. The conversion can take a few minutes, depending on the size of the file. Other applications to consider include: Editing PDF Given the nature of file
conversion, the easier you can make the original, the better the converted file will look. Of course, if the original PDF author blocked the file for editing, you won't be able to do much about it. You should especially try to remove (or customize) any overlapping items as much as possible. You'll find that
removing overlapping items will make it easier to edit a converted PPT file. Conversion software will try all the items on the PDF page and make them individually edited. Blocking content increases the likelihood of software misrepresenting each piece of content. No PDF-to-PowerPoint solution is perfect
whenever you you PDF files in PowerPoint format, you have to remember that the final product is unlikely to be perfect. Transforming PDFs is difficult at the best of times, especially when converting between formats such as PDF and PPT. All conversion programs only make guesses about what the file
should look like. You should always be willing to do a reasonable amount of post-conversion editing if you plan to use the presentation in a professional environment and want to avoid slideshow errors. If you start to think that converting a file from PDF to PowerPoint sounds like a lot of hassle, you might
consider converting it to a Word file instead. How do I track my cell phone location using only my lost phone number? Trying to find or look after the baby? This app can help. By Dan Price (1390 articles published) More from Dan Price how to convert powerpoint into handouts. how to convert powerpoint
into pdf handout. how to convert powerpoint slides into handouts
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